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ABSTRACT
Critical Review of Inundation Mapping Procedures
for Floodplain Management
Richard M. Wise
Inundation mapping is a major component of floodplain management, providing critical
information as to the consequences of potential failures of flood control structures, such as dams.
To develop inundation maps, a dam and river system are modeled with engineering computer
programs, and a simulation of the dam failure is performed to generate data for the flood. This
output data is input into other programs to develop inundation maps. Inundation maps have
traditionally been produced in a paper format, but recent advances in computer modeling have
provided the capability for virtual inundation maps. Thus, these mapping methods need to be
investigated to determine the applications and relevance to floodplain management.
The goal of this research is to advance the development and use of inundation maps by
floodplain managers and emergency agencies. In this work, a simulation of a potential dam
failure was performed for a candidate river system, and the inundation maps were created using
two procedures: Terrain Tiles and Google Earth. An analysis of the strengths and weaknesses of
each mapping procedure was conducted. The Terrain Tiles procedure has advantages in
displaying critical information, such as arrival times and water depths. However, this mapping
procedure is more labor-intensive, and the online file sharing may not be accessible for all users.
The strengths of the Google Earth procedure include two-dimensional and three-dimensional
views for analysis, user-friendly file sharing, and the inclusion of built-in critical infrastructure
and terrain data. Drawbacks of this procedure are that the inundation must still be generated in
ArcGIS, that the display of critical information is not as clear, and that the online file sharing
may pose security issues. Thus, the Terrain Tiles procedure should be used for the development
of emergency response measures, while the Google Earth procedure should be used by
emergency responders in the event of an actual emergency.
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1.0 Introduction
Flood control is a vital safeguard in society, protecting the public from the devastation to
property and health caused by high water levels. A key component of flood control is the use of
dams to control flow on major rivers. The United States Army Corps of Engineers (USACE)
manages 569 dams throughout the United States. However, these dams have a design life of 50
years, and a majority of the dams are approaching or have exceeded this design life (ERDC,
2010). Therefore, the USACE is committed to evaluating these structures for risk of potential
failure, integrating risk reduction methods, and communicating and understanding these risks
(USACE, 2008).
Planning for a potential dam failure requires an understanding of the effects of the flood
in order for proper mitigation measures to be implemented. A useful tool for visualizing these
effects is inundation mapping. The development of inundation maps involves several steps,
beginning with the modeling of the structure and river networks in computer software. The
output data is then input into other computer programs for the creation of the maps. Inundation
maps are typically produced as paper maps, but recent technological advances provide the
capability to create virtual maps. Since virtual inundation maps offer new methods of
presentation and analysis of flood impacts, an assessment of the strengths and weaknesses of
paper and virtual maps needs to be performed to determine the appropriate applications of each
in floodplain management. This research consists of four tasks: i) conduct literature reviews on
current software for floodplain mapping, ii) generate inundation for a dam failure and produce
paper and virtual maps, iii) identify strengths and weaknesses for each mapping procedure and
determine applications in floodplain management, and iv) provide recommendations for further
development.
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1.1 Objectives and Purpose
The objectives of this work are to examine the key differences in the development and
use of paper and virtual inundation maps. Additional objectives are to discuss the computer
programs used in the creation of inundation maps (HEC-RAS, HEC-GeoRAS, ArcGIS, and
Google Earth); to identify input data and generated output; and to perform data analysis based on
the functionality, strengths and weaknesses, and need for further development and refinement.
The main purpose of this research is to advance the development and use of inundation maps by
floodplain managers and emergency agencies.

1.2 Work Scope
The research process is divided into four separate tasks comprising the work scope. The
work scope is outlined in more detail in the following sections.
1.2.1 Perform Literature Review
The purpose of the literature review is to establish the necessity of creating inundation
maps for use in floodplain management. The literature review provides current guidelines and
standardization practices developed by the Federal Emergency Management Agency (FEMA).
Furthermore, relevant computer software used in the inundation mapping process are presented,
and the applications of each program are discussed in regards to the research efforts.
1.2.2 Create Inundation Maps
The development of inundation maps involves several steps, beginning with data
acquisition. Hydrologic events are used to simulate a dam failure, generating the resulting
inundation as the flood moves downstream. Output data such as water elevations and flow rates
are imported into mapping software, where the inundation is visualized. The inundation is then
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processed in either a paper or virtual format for analysis and use by floodplain engineers and
emergency responders. In this work, two mapping procedures are outlined to establish the steps
for creating both paper and virtual inundation maps.
1.2.3 Analyze Data Output
The outputs from each mapping procedure are analyzed using several criteria related to
the functionality in the development of emergency response measures. These criteria involve the
ease of development for each mapping procedure, the manner in which critical information is
presented in each map, and the accessibility of the maps to multiple agencies and audiences.
Based on these criteria, the strengths and weaknesses of each mapping procedure are determined,
leading to an evaluation of the proper applications of each map in floodplain management.
1.2.4 Provide Recommendations
The significant results of this research are discussed, including the advantages and
disadvantages of each mapping procedure in relation to floodplain management practices.
Appropriate applications for each mapping procedure are then detailed. Lastly, a discussion of
future development and possible improvements is presented.
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2.0 Literature Review
Floodplain management serves a vital purpose in society, protecting public property and
health, maintaining flood control, preserving water quality for communities, and establishing
emergency response protocols (Bond, 2009). These practices are outlined in the National Flood
Insurance Program (NFIP), managed by FEMA. The NFIP provides flood insurance for almost
20,000 communities across the United States and helps to reduce future flood damage through
the development of flood hazard maps (FEMA, 2010). These maps communicate the risks and
potential impacts of floods, enabling communities to prepare for such disasters. Therefore, flood
mitigation efforts rely on the creation of inundation maps in order to develop appropriate
response measures for crisis situations, including dam failures.
The results of a dam failure are devastating to communities downstream, having
widespread impacts on critical infrastructure. Inundation maps depicting the estimated flood
extents and water surface elevations provide an understanding of the effects to critical
infrastructure. Thus, inundation maps enable floodplain engineers and emergency responders to
develop appropriate evacuation and mitigation protocols. In order to aid the display of
infrastructure in inundation maps, FEMA has established a classification system of critical
infrastructure sectors depicted in Table 1 (DHS, 2008).

4

Table 1: Critical Infrastructure Sectors

By producing inundation maps showing the flood extents at consecutive times after a
dam failure, the inundation’s arrival times to important areas and critical infrastructure are
determined. These arrival times are key components of Emergency Action Plans, helping
emergency responders to coordinate mitigation measures at the optimal time for various
locations downstream. Because of the crucial information contained within inundation maps,
these maps play an integral role in floodplain management and dam safety.
Several engineering software programs are used for the development of time-stepped
inundation maps, including HEC-RAS, HEC-GeoRAS, ArcGIS, and Google Earth. First, the
dam and river system are modeled in HEC-RAS, and a hydrologic event is used to simulate the
dam failure. Next, the generated HEC-RAS data is processed using HEC-GeoRAS, and tools in
ArcGIS are used to create paper inundation maps. An alternate mapping method is to export the
inundation into Google Earth for the development of virtual maps, which is the focus of this
research.
5

2.1 Review of HEC-RAS
Created by the USACE, HEC-RAS is engineering software that models systems of both
natural and man-made channels. Once the geometry data for the network is set up, HEC-RAS
simulates water flow through the network using one-dimensional hydraulic calculations. HECRAS contains the capability to perform various analyses using four separate modules: steady
flow, unsteady flow, sediment transport, and water quality (USACE, 2011B).
The steady flow module performs calculations for river systems where the flow is
gradually varied with subcritical, supercritical, or mixed flow profiles. These calculations are
based on Manning’s equation, although the momentum equation is used to provide flow data
around bridge piers, at river confluences, and at hydraulic jumps. HEC-RAS also allows
structures located in the floodplain, such as culverts and weirs, to be included in the analysis.
Because of these features, the steady flow module is useful for performing studies involving
floodplain analysis (USACE, 2011B).
Similar to the steady flow module, the unsteady flow module computes flow data for an
entire river network. However, this module is designed to perform calculations for systems
where the water surface profiles and flow characteristics vary with time. The unsteady flow
module has the capability to incorporate various flow conditions, including subcritical flow,
supercritical flow, mixed flow, drawdowns, and hydraulic jumps. Furthermore, the unsteady
flow module enables users to input floodplain obstructions such as bridges, culverts, and weirs
into the simulation. Due to the capabilities contained within this module, the unsteady flow
module is suitable for simulating the overtopping and failure of dams, water releases from dam
operations, and flow through pumping stations and pipe systems (USACE, 2011B).
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The sediment transport module simulates scour and deposition in river channels over
time. Hence, this module is used to study the effects that changes in the flow rate through the
channel or the modification of the channel’s cross-sectional geometry have on scour and
deposition. Further applications of the sediment transport module include simulating the scour
of river channels as a result of extreme floods, assessing the deposition of soil in reservoirs, and
determining the impacts dredging may have on deposition (USACE, 2011B).
The water quality module provides capabilities for environmental analyses of rivers and
streams. The analyses contained within the module are carbonaceous biological oxygen demand,
dissolved oxygen, algae, dissolved phosphorus, and dissolved nitrogen. As a result, the water
quality module is a vital tool for the determination of the purity of water for consumption and the
preservation of ecosystems (USACE, 2011B).
Once the appropriate module has been selected and the simulation has been performed,
HEC-RAS allows users to create graphics and reports of the output data. For instance, HECRAS produces graphics of the channel geometry, such as the river network and cross-section
profiles. Additionally, rainfall and flow data such as hydrographs and water velocities are
contained within tables in HEC-RAS. Another tool in HEC-RAS, RAS Mapper, provides the
capability to use the generated output data for the purpose of inundation mapping within HECRAS (USACE, 2011B).
While HEC-RAS contains many features and a wide variety of analysis capabilities, only
a select few are useful for the purposes of this research. Since the unsteady flow module
performs hydraulic calculations for flow characteristics that change over time, this HEC-RAS
simulation provides the most realistic depiction of the flood’s movement downstream after the
dam failure.
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2.2 Review of HEC-GeoRAS
HEC-GeoRAS is a program compatible with both HEC-RAS and ArcGIS Desktop,
providing a means to transfer data between the two computer programs. Developed by the
USACE, HEC-GeoRAS is a software extension for ArcGIS Desktop that allows for the import of
GIS data into HEC-RAS and the visualization of HEC-RAS output in ArcGIS Desktop. HECGeoRAS contains tools for digitizing river networks in ArcGIS Desktop, with capabilities for
assigning station values, flow paths, and river names. Further capabilities include the
development of cross-sectional cut lines and the input of elevation values. Once the river
network is digitized, the geometry data is imported into HEC-RAS, where hydraulic simulations
are performed for the river system. The HEC-RAS output data is then visualized and processed
by HEC-GeoRAS for a variety of applications, including flood hazard mapping, damage
calculations, and emergency response (USACE, 2011A).
The capabilities contained within HEC-GeoRAS are crucial to the creation of timestepped inundation maps. The geometry data for the river network is generated in ArcGIS
Desktop using HEC-GeoRAS, providing the input data for HEC-RAS. Hydrologic events are
used to simulate the dam failure, and HEC-RAS produces output data for the resulting
inundation. HEC-GeoRAS is then used to visualize the output data in ArcGIS Desktop, where
tools in both HEC-GeoRAS and ArcGIS Desktop are utilized to process the data for the
inundation and to develop the inundation maps.

2.3 Review of ArcGIS
Created by the Environmental Systems Research Institute, Inc. (ESRI), ArcGIS is a
computer system used for displaying geographic data. ArcGIS has a multitude of uses in today’s
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society, including processing geographic data, developing and analyzing maps, and
disseminating geographic information. ArcGIS Desktop, ArcGIS Server, ArcGIS Explorer,
ArcGIS.com, ArcGIS online, and Mobile GIS are several programs that comprise ArcGIS. Each
program provides users with unique processing functions. ArcGIS Desktop is a software
program that allows users to create maps on computers with a Windows operating system. After
the maps are developed, ArcGIS Server, ArcGIS Explorer, ArcGIS.com, and ArcGIS online are
used in combination to allow users to upload, publish, and share the maps online. Mobile GIS
allows for users to then access uploaded material in the field using mobile phones, Tablet PCs,
and advanced GPS data collectors (ESRI, 2011A).
The main computer program used for GIS tasks such as developing maps and analyzing
data is ArcGIS Desktop. ArcGIS Desktop comprises several key components to perform these
tasks, including ArcCatalog, ArcGlobe, ArcMap, ArcScene, ArcToolbox, and ModelBuilder.
ArcCatalog is a tool that allows for proper file management and the organization of GIS data.
ArcMap is a tool where the GIS data is compiled and analyzed. In ArcMap, the concept of
overlaying features is used, allowing for points and other data to be displayed on background
imagery or terrain. This information is then stored by ArcMap in a map document where
analyses are performed by ArcToolbox. All the tools developed by the ESRI to process
geographic data are contained within ArcToolbox. Data analysis is performed by using these
tools individually or by combining the tools into a flow chart format using ModelBuilder. The
combining of processing tools in ModelBuilder is helpful when the data analysis follows a set
procedure and requires repetition. In addition to these different components, ArcGIS Desktop
has customization capabilities through extensions that offer advanced analysis functions. Two of
these extensions, Spatial Analyst and 3D Analyst, provide the ability to analyze three-
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dimensional terrain data. Because the overlay function in ArcMap only allows for geographic
data to be viewed in a two-dimensional plane, ArcGlobe and ArcScene are used to project
geographic data in a three-dimensional environment. Therefore, ArcGIS Desktop provides a set
of capabilities that enables users to visualize and process geographic data for a multitude of
applications (ESRI, 2011B).
ArcGIS Desktop is an important program in the creation of inundation maps. Once a
program such as HEC-RAS is used to perform hydraulic modeling and export the data, ArcMap
and HEC-GeoRAS are used for visualizing and processing the results. Once the flood has been
developed, other layers such as aerial photography or topography, locations of critical
infrastructure, and transportation routes are supplemented to the map to provide spatial
referencing and to serve as a basis for the analysis of the flood’s impacts. The creation of these
maps provides emergency agencies with a visualization of the flood’s effects and allows for the
coordination of emergency management procedures. Therefore, ArcGIS Desktop is vital for the
development of inundation maps.

2.4 Review of Google Earth
Google Earth is a virtual globe and map program developed by Google. This program is
available in three different versions: Google Earth, Google Earth Pro, and Google Earth
Enterprise. Google Earth is a free version of the software, while Google Earth Pro and Google
Earth Enterprise contain additional professional tools that must be purchased. The basic features
of Google Earth include the ability to explore geographic information, view three-dimensional
buildings, and upload data for display. By viewing models on the virtual globe, users can
visualize how projects would appear in actuality, which enables users to better understand the
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impacts the projects would have on existing features. Google Earth also offers methods of
sharing created maps and information online. Maps uploaded to Google Earth can be shared
with the Google Earth Community and accessed using Android phones and tablets, iPhones, and
iPads. Thus, Google Earth provides an environment for a deeper analysis and visualization than
plans or paper maps offer (Google, 2011).
Google Earth has many features that are useful for the purposes of this work. Once the
inundation extents have been developed using ArcGIS Desktop, the inundation is exported into a
format compatible with Google Earth. By importing this data into Google Earth, the flood is
displayed on existing imagery, and the resulting interactive map provides further analysis than
the two-dimensional view offered by ArcMap. As a result, Google Earth provides another means
of visualizing the effects of a dam failure, which makes this computer program an effective
means of inundation mapping.
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3.0 Hydrologic Modeling and Inundation Mapping Procedures
Since the input data is identical for the development of paper and virtual inundation
maps, this data is first presented. Next, the data processing procedure is outlined, and the
methods for creating the paper and virtual maps are discussed.

3.1 Data Collection
For this research effort, the United States Army Corps of Engineers developed a HECRAS project file of a candidate dam and river system. This model contains several failure
scenarios for the dam, as well as key data for the river network, including the following: river
centerlines, cross-sections along the rivers depicting channel geometry, water storage areas, and
bank points along the rivers outlining where the floodplain begins. This input data is represented
in Figure 1, where the river centerlines are dark blue lines, the cross-sections are green lines, the
storage areas are light blue regions, and the bank points are red dots.

Figure 1: Input Data for HEC-RAS
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After acquiring the HEC-RAS model from the USACE, the data contained within the
model was verified by performing a visual inspection to assess the accuracy of the data for the
purposes of this research. Since the data derived from field measurements of the dam and river
system could not be confirmed precisely, the cross-section profiles of the rivers were examined
to ensure the geometry conformed to topography consistent with the study area. Once the data
was determined to be accurate, the remaining data required for the analysis was obtained.
In addition to the HEC-RAS model, the USACE supplied terrain data based on Light
Detection and Ranging (LiDAR). The elevations obtained from LiDAR were processed into
bare earth Digital Elevation Models (DEMs) composed of grids with three separate spatial
resolutions: 30-meter, 10-meter, and 2-meter. Since the spatial resolution refers to the
dimension of each grid within the DEM, the 2-meter DEMs are chosen as the basis for this
research in order to obtain a level of accuracy of two meters for the inundation. The North
American Datum of 1983 (NAD83) is the coordinate system of the DEMs, and the Albers equalarea conic projection is used to model the study area on a two-dimensional surface with minimal
distortion. In order to analyze the impacts of the inundation, critical infrastructure data for the
study area was acquired from the USACE. For the creation of paper maps, background imagery
was downloaded from the West Virginia GIS Technical Center in the form of aerial
photography, transportation routes, and shapefiles of United States counties and cities
(WVGISTC, 2011). After procuring this input data, the steps in the development of paper and
virtual inundation maps are detailed.
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3.2 Hydrologic Modeling
Since an entire river network has an extensive amount of data that needs to be processed,
the Terrain Tiles procedure is utilized to segment the network into smaller areas for analysis.
Thus, in this procedure, Digital Terrain Models (DTMs) are produced from the DEMs, and the
tools contained within HEC-GeoRAS are used to process the inundation based on the individual
DTMs.
3.2.1 Create Shapefile in ArcCatalog
The first step in the process of developing DTMs is creating a polygon shapefile. This
step is completed in ArcCatalog, where the new shapefile is given a name and coordinate system.
With these attributes assigned to the shapefile, ArcMap is opened to begin the process of creating
the DTMs from the DEMs.
3.2.2 Draw Polygon for First DTM
In a blank ArcMap document, the DEMs, the polygon shapefile, the river centerline, and
the cross-section cut lines are added to facilitate the process of creating the DTMs. After adding
this data, polygons are drawn to delineate the boundaries of the DTMs. Using the Sketch Tool
from the Editor Toolbar, an area is drawn around the first DEM that encompasses the entire
DEM section and corresponding cross-sections without intersecting any lines representative of
the cross-sections. Figure 2 demonstrates how the polygon shapefile is drawn around the first
DEM section and between the cross-sections.
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Figure 2: Draw First Polygon

3.2.3 Specify Analysis Options
Once the polygon is drawn, the next step is to specify the analysis options of the
shapefile. Figure 3a displays the General tab, which allows for the analysis mask to be changed
to the polygon shapefile. Figure 3b shows the Extent tab; in this tab, the extent of the analysis is
specified as the polygon shapefile, and the DEM is chosen as the snap extent. Lastly, Figure 3c
illustrates the Cell Size tab, which allows for the cell size of the analysis to be set as the DEM.

a

b
Figure 3: Set Analysis Extents
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c

3.2.4 Generate First DTM
After the analysis options of the shapefile are selected, the Raster Calculator Tool is used
to create the DTM. Once created, the DTM appears as a layer in ArcMap. The layer is then
saved using the Make Permanent Tool. Saving the layer ensures that in later steps HECGeoRAS can process the data through a proper file path and directory.
3.2.5 Generate Other DTMs
With the layer saved, the polygon drawn for the creation of the first DTM is deleted.
Next, the Sketch Tool is used to draw the second polygon around the next DEM section,
ensuring to overlap a portion of the first DTM and that the cross-sections are not intersected by
the boundary. Figure 4 shows the second polygon drawn to overlap a portion of the clipped
DTM without intersecting the cross-sections.

Figure 4: Draw Next Polygon

These steps are repeated for the rest of the DEM. For HEC-GeoRAS to process this data,
the DTMs must have Triangulated Irregular Networks (TINs) created from contours. In order to
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create contours of a specified interval, the Contour Tool from Spatial Analyst is used. With the
contours created, the TIN is then generated using the Create/Modify TIN category in the 3D
Analyst Toolbar. In the Create TIN From Features dialog box, presented in Figure 5, the
contours are assigned as the source for creating the TIN, and the file path for the generated TIN
output is specified.

Figure 5: Generate TIN from Contours

These steps are repeated for each of the DTMs until a TIN has been generated for each. The
TINs are then saved, and HEC-GeoRAS processing can begin.
3.2.6 Create Geometry Map
To produce an inundation from DTMs and TINs in ArcMap, the multiple terrain function
of HEC-GeoRAS is used. The process starts when ArcMap is opened and saved. Next, the
ApUtilities menu in HEC-GeoRAS is used to add a new map. This new map is given the name
Geometry to denote that this map layer is used to set up the geometry for the analysis.
With the new map set up, the TINs that were created previously are added to the
document. Although the addition of the TINs is not required by HEC-GeoRAS, this step is
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useful in guaranteeing that all the TINs overlap. Furthermore, the cross-section cut lines and
river centerline are added to provide more data for the analysis to be performed.
3.2.7 Generate Layer for Terrain Tiles
Once this data has been added, the boundaries of the analysis are set using HECGeoRAS. This step involves choosing the Terrain Tiles Tool from RAS Geometry. The Terrain
Tiles Tool then generates a layer that is given the name of TerrainTiles.
3.2.8 Draw Terrain Tile Polygon for First TIN
After the Geometry map contains the newly created TerrainTiles layer, the Sketch Tool is
used to draw polygons along the study area, and HEC-GeoRAS is used to process the data
contained within the polygons. The process of creating terrain tiles is simplified by displaying
one TIN at a time and drawing a polygon around the TIN and corresponding cross-sections, as
demonstrated by Figure 6.

Figure 6: Draw Polygon for First TIN
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3.2.9 Draw Terrain Tile Polygon for Second TIN
With the first terrain tile drawn, the second TIN is turned on, while the first TIN is no
longer displayed. Next, a check for a continuous analysis is implemented by confirming that the
first polygon contains the lead edge of the second TIN. Once the check is performed, the Sketch
Tool is then used to draw the second polygon, ensuring that the first polygon is overlapped.
Figure 7 represents the display after the second polygon is drawn.

Figure 7: Draw Polygon for Second TIN

3.2.10 Remove Overlap
Once the second polygon is created, the overlap between the first and second polygons is
removed. The Clip Tool from the Editor Toolbar is chosen to accomplish this task. To eliminate
any gaps that may interfere with the analysis, zero is entered for the buffer distance inside the
Clip dialog box, and the overlap area is discarded, as shown by Figure 8.
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Figure 8: Clip Terrain Tiles

Once these features are specified and the dialog box is closed, the boundary of the second
polygon is joined with the edge of the first polygon. This process is then followed for the
remaining TINs.
3.2.11 Complete Attribute Table
Once the terrain tiles are drawn for the entire study area, the TerrainTiles layer is rightclicked in the Table of Contents, and the Attribute Table is opened. Within the TerrainTiles
Attribute Table, three columns need to be populated with various data and file path information.
To identify the terrain data as a TIN, a number one is placed in the TerrainType column for all
the polygons. For file management purposes, the TileName column is populated with the names
of the TINs that correspond with the specific polygons, allowing for HEC-GeoRAS to identify
the specific TIN. Lastly, the file path is set for each polygon in the TileDirectory column, which
allows HEC-GeoRAS to locate the TINs once the data processing begins. An example
TerrainTiles Attribute Table that has been populated is shown in Figure 9.
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Figure 9: Completed Attribute Table

After the Attribute Table has been populated, a check is performed to confirm that the
river cross-sections are contained within specific polygons and that the polygons have
corresponding TINs. Next, the terrain tiles are digitized by choosing Stop Editing and saving the
edits.
3.2.12 Export GIS Data in HEC-RAS
Once the terrain tiles have been created, the HEC-RAS data is needed to start the
analysis. To import the HEC-RAS data into ArcMap, the dam failure scenario is simulated in
HEC-RAS, and the scenario’s output intervals are chosen. For this specific failure scenario, an
output is created for every hour. Once the output data is created, the Export GIS Data function in
the HEC-RAS File menu is chosen, displaying the options for exporting the data, as depicted in
Figure 10.
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Figure 10: Export GIS Data

At the top of the dialog box, the export file is given a file destination. Next, the river
reaches and storage areas are chosen using the Select Reaches to Export and Select Storage
Areas to Export functions, respectively. The output profile to be exported is then chosen, and the
data is exported to the file destination by selecting Export Data.
3.2.13 Perform HEC-GeoRAS Layer Setup
After the data is exported from HEC-RAS, the exported file needs to be converted to a
file format that is compatible with HEC-GeoRAS. This step is completed by opening the
ArcMap file that contains the terrain tiles and choosing the Import RAS SDF File Tool. The
exported data is then converted to an XML file format. With the data file converted, the analysis
layer is set up by choosing Layer Setup from the RAS Mapping menu; the resulting dialog box is
illustrated in Figure 11.
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Figure 11: Analysis Setup

In the Layer Setup dialog box, the analysis type is determined to be either a new or
existing analysis. In this research effort, the analysis type is a new analysis, and an arbitrary
name is assigned to the analysis. Next, the RAS GIS Export File is chosen to be the XML file
created in the previous step. Since there are multiple terrain tiles for the analysis, the terrain data
is set to the Multiple option, and the DTM Tiles Layer is set to the location of the TerrainTiles
dataset. Lastly, an Output Directory is given for the data produced during the analysis, and OK
is selected to complete the Layer Setup.
3.2.14 Generate Inundation
After the layer is set up, the next step is to import the HEC-RAS data into ArcMap.
Using the RAS Mapping dropdown, Import RAS Data is chosen, opening the dialogue box
which contains importing options. In this dialog box, either a New or Classic (Personal)
Geodatabase can be specified to import the HEC-RAS data. For this application, the Classic
Geodatabase option is chosen for a faster importing time. Next, OK is selected, and the HECRAS data is visualized in ArcMap. With the bounding polygon, cross-sections, river centerlines,
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and storage areas displayed, a Water Surface TIN is created from these features. To accomplish
this task, Inundation Mapping is selected from the RAS Mapping menu to open the Water
Surface Generation dialog box. In the Water Surface Generation dialog box, the profile of the
water surface imported from HEC-RAS is selected, and the options pertaining to the layer’s
output are all chosen with the exception of Merge Floodplain Features, as this option merges the
output into a single entity. Selecting OK creates the Water Surface TIN for the profile. After the
TIN is generated, the inundation is then created. This step is accomplished by choosing
Inundation Mapping under RAS Mapping and selecting the Floodplain Delineation Using
Rasters Tool. In the resulting dialog box, illustrated by Figure 12, the water surface profile for
the analysis is chosen, and Merge Floodplain Features is left unchecked; OK is selected to
generate the inundation.

Figure 12: Begin Floodplain Analysis

3.2.15 Review Generated Output
Two separate inundations are created when the HEC-GeoRAS analysis has been
completed. The first inundation, shown in Figure 13, represents the flood extents with a solid-fill
polygon. The second inundation, displayed in Figure 14, shows a higher level of detail into the
depths of the flood waters by the use of darker variations of the same color.
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Figure 13: Flood Extents

Figure 14: Water Depths

For this research, HEC-GeoRAS was used to create the inundation encompassing the
river network for each time step of the analysis. The processing time for each time step ranged
from 18 to 48 hours depending on the amount of data. The file sizes for the inundation were
between 170 and 200 gigabytes, with an average size of 190 gigabytes. Once the inundation is
generated for the study area, the process of creating paper or virtual inundation maps begins.

3.3 Paper Inundation Mapping Using ArcGIS
The tools in ArcGIS Desktop are used to create paper inundation maps based on the
inundation polygon. In this procedure, background imagery is used to provide a spatial reference
for the inundation and to facilitate the analysis of the flood’s impacts. The steps for the creation
of paper inundation maps are outlined in the following sections.
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3.3.1 Merge Individual DEMs
In order to provide a context for the inundation extents, the inundation polygon is
overlain on either aerial photography or contours. Due to the additional insight into water depths
provided by topography, contours are used for the background of the inundation maps in this
research. To facilitate the creation of contours over the entire study area, the individual DEMs
are first merged together. Thus, the DEMs are added into ArcMap using the Add Data function,
and ArcToolbox is expanded to reveal the Data Management Tools category. In this category,
the tool Mosaic to New Raster is chosen, and the individual DEMs are selected in the dialog box.
Also, Entire Study Area is input as the name of the resulting file, and the output location is
specified. Once the Entire Study Area DEM is created, the file is added into the ArcMap
document. The individual DEMs are no longer needed, and are removed from the document.
3.3.2 Generate Contours from Merged DEM
Once the terrain data for the entire study area is contained within a single DEM, contours
are then generated based on this DEM. To shorten the processing time, the analysis environment
is first specified. In ArcMap, Options is selected from the Tools dropdown menu, and the
Geoprocessing tab is chosen in the dialog box, as shown in Figure 15.
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Figure 15: Geoprocessing Options

In the Environment Settings category, Environments is selected, opening the dialog box
where the ArcMap workspaces are contained. Under General Settings, the Current Workspace
and the Scratch Workspace are specified as the full path to the folder where the Entire Study
Area DEM is located, as illustrated in Figure 16.

Figure 16: Set Workspaces
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Once the workspaces are selected, the contours are generated. Using the Spatial Analyst
dropdown menu, Contours is chosen from the Surface Analysis category. Figure 17 depicts the
Contour dialog box, where the Input surface is defined as the Entire Study Area DEM and the
interval for the contours is chosen. For this research, a Contour interval of 50 feet is used for the
effective display of contours at the scale of the inundation maps. Furthermore, the output
directory is specified as the folder where the Entire Study Area DEM is located. Selecting OK
generates the contours in the ArcMap document, overlain on the Entire Study Area DEM.

Figure 17: Generate Contours

3.3.3 Add Analysis Layers
Since the contours provide the necessary elevation data, the Entire Study Area DEM is
removed from the ArcMap document. In order to provide further details on the impacts of the
inundation, transportation routes, critical infrastructure, and cities are added to the document
using the Add Data function. For this research, the transportation routes selected for inclusion in
the maps are interstates, US routes, state routes, and minor roads such as county routes. The data
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contained within the road, infrastructure, and cities layers extends beyond the scope of the study
area. Therefore, these layers are clipped to eliminate extraneous data.
3.3.4 Create Boundary Shapefile
In order to clip these layers, a polygon shapefile is created in ArcCatalog. After selecting
the folder where the new shapefile is saved, the New menu is chosen from the File dropdown,
and Shapefile is selected. In the dialog box, Boundary is entered as the name for the shapefile,
and polygon is chosen as the Feature Type. Also, the coordinate system for the shapefile is
selected to be consistent with the other files composing the maps by choosing Edit. In the
Spatial Reference Properties dialog box, Import is used to select the coordinate system and
projection of the Entire Study Area DEM. Once the shapefile is created, ArcCatalog is closed,
and the process continues in ArcMap.
3.3.5 Draw Analysis Boundary
The Boundary shapefile is added into the ArcMap document using the Add Data
function, and the Editor Toolbar is used to clip the layers. Start Editing is chosen from the Editor
dropdown, and in the dialog box, the Boundary shapefile is specified as the Target layer. Using
the Sketch Tool, a polygon is drawn around the outer edge of the Entire Study Area DEM. Since
the purpose of clipping the layers is to limit the data to the study area, the polygon is drawn as
close to the edge of the DEM as possible. Figure 18 demonstrates this procedure by depicting
the extents of the transportation routes, drawn in the colors found in the Table of Contents, in
relation to the Entire Study Area DEM and boundary polygon, shown in light blue.
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Figure 18: DEM Boundary with Transportation Routes

3.3.6 Clip Analysis Layers
After sketching the boundary polygon, the next step is to save the polygon for use in the
clipping process. Thus, the Editor dropdown menu is used to select Save Edits, and ArcToolbox
is opened. Under the Analysis Tools category in ArcToolbox, the Extract category is expanded,
revealing the Clip Tool. This tool is used to clip each of the individual layers to the extents of
the boundary polygon. Figure 19 demonstrates the clipping process for the US routes. The Input
Features are specified as the US routes layer, while the Boundary shapefile is selected as the Clip
Features. After choosing the output location and providing a name for the file in Output Feature
Class, selecting OK creates a layer containing the clipped US routes.
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Figure 19: Clip Layers

This process is repeated to clip the remaining road layers, as well as the critical
infrastructure and cities layers. Once the desired layers are clipped, the original layers and the
Boundary shapefile are removed from the ArcMap document, and the clipped layers are added
using the Add Data function.
3.3.7 Label and Assign Symbology to Analysis Layers
To enhance the display of the cities, transportation routes, and critical infrastructure,
appropriate labels and symbols are assigned. To customize the appearance of the labels for the
cities layer, the layer is double-clicked in the Table of Contents. Figure 20 shows the Layer
Properties dialog box, where the Labels tab is used to set the properties for the labels, such as the
font and size. For this research, Times New Roman is used as the font for the labels, with a font
size of 20.
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Figure 20: Set Label Properties

In order to ensure that the labels are visible when overlain on the background imagery, a
mask is added. Under the Labels tab, Symbol is chosen, and in the resulting dialog box,
Properties is selected. In the Properties dialog box, the Mask tab is selected, as shown in Figure
21. In order to include a mask with the labels, the Halo option is specified, along with the size of
the mask. For this application, a size of 6 is used for the mask.

Figure 21: Specify Label Mask

Once the properties for the labels are set, the labels are displayed on the map by choosing
Label Features from the menu that appears after the cities layer is right-clicked in the Table of
Contents. This procedure is repeated to place labels on the transportation routes. For this
research, the interstates, US routes, and state routes are labeled in Times New Roman, with a
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font size of 8 and a mask of size 2. Since the default placement of the labels may overlap critical
information, the labels are converted to annotation to allow for the labels to be moved manually
with the Select Elements Tool. This step is accomplished by right-clicking the desired layer in
the Table of Contents and choosing Convert Labels to Annotation from the menu.
Due to the high concentration of critical infrastructure in the study area, the labels for the
individual structures are not activated; instead, appropriate symbols are assigned to each critical
infrastructure category to facilitate emergency response planning. For each category, the symbol
is changed from a point to an icon consistent with the facilities in the category. In the Table of
Contents, the point symbol for a critical infrastructure category is double-clicked. Figure 22
shows the Symbol Selector dialog box, where More Symbols is used to choose an appropriate
icon from a collection of symbols common to a variety of industries. This process is repeated for
the remaining critical infrastructure categories.

Figure 22: Assign Symbology
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3.3.8 Draw Map Areas
The scope of study area in this research does not allow for a sufficient level of detail to be
displayed when the entire inundation is shown on a single map; thus, map areas with dimensions
of 6-miles by 8-miles are used to map segments of the inundation. In order to create the map
areas, a polygon shapefile is created in ArcCatalog following the same procedure associated with
the Boundary shapefile. After creating the MapAreas shapefile, the shapefile is added into
ArcMap using the Add Data function. The Editor Toolbar is used to select Start Editing, with
the MapAreas shapefile as the Target layer. Using the Sketch Tool, a rectangle with a height of
six miles and a length of eight miles is drawn, and the dimensions are verified by the Measure
Tool, found in the Tools Toolbar. Figure 23 shows one map area of the inundation, specified by
the 6-mile by 8-mile rectangle. After creating the map area, Save Edits in the Editor dropdown
is chosen to save the map area.

Figure 23: Sample Map Area
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Since the study area requires multiple map areas, the rectangle is selected and copied
using the Ctrl C keyboard command. Copies are then pasted into the ArcMap document with the
Ctrl V keyboard command. Using the Select Elements Tool, the map areas are selected and
moved to proper locations along the river. For this research, 23 map areas are needed to
encompass the entire study area. Once the map areas are created and placed, Save Edits is
chosen from the Editor dropdown, followed by Stop Editing.
3.3.9 Choose Representative Cross-Sections
To provide a visualization of the water surface elevation in relation to the channel profile,
a representative cross-section is selected for each map area. The XS Cutlines layer is added into
the ArcMap document using the Add Data function, and the symbol size is changed to zero to
allow for only the representative cross-sections to be viewed. In the Table of Contents, the XS
Cutlines layer is right-clicked, and Open Attribute Table is selected from the menu. Figure 24
shows the Attribute Table, where the representative cross-section is selected and displayed on the
map by clicking the gray box to the left of the Shape category. For this research, representative
cross-sections are selected based on the proximity to the center of the map area and the lack of
overlap with critical infrastructure.

Figure 24: Select Representative Cross-Section
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Once the representative cross-sections are selected, HEC-RAS is used to create plots of
the cross-section profiles with the water levels in the river channels. After opening the dam
failure simulation in HEC-RAS, Cross-Sections is chosen from the View dropdown. To specify
the profile for the desired representative cross-section, the station number, river, and reach are
selected in the dialog box. The Play function illustrates the water level rise and fall in the
channel throughout the simulation; thus, this tool is used to display the water elevation at a
specific time, since the water level in the channel needs to be consistent with the inundation
shown in the map. Once the desired time period is chosen, a screenshot of the profile is taken,
and Paint is used to crop the image, as illustrated in Figure 25. After cropping, the image file is
saved for import into the inundation map.

Figure 25: Create Profile

3.3.10 Select Built-In Map Template
In order to create inundation maps based on the map areas, the ArcMap environment is
changed to Layout View by clicking the icon in the lower left-hand corner. Once in Layout
View, the map is organized by choosing a template. Change Layout is selected, opening the
Select Template dialog box. This dialog box contains several built-in map templates, and for this
research, LandscapeModernInset is used, as shown in Figure 26.
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Figure 26: Choose Map Template

Once the template is selected, the page size for the inundation maps is specified by
choosing Page and Print Setup under the File dropdown. In the dialog box, the page size is
selected, and the orientation for the maps is specified. Since these properties differ from the
default setup, Scale Map Elements proportionally to changes in Page Size is selected to ensure
that distortion of the data layers does not occur.
3.3.11 Customize Map Template
Since the template contains preset data frames, the template is modified in order to suit
the format for the inundation maps. ArcMap displays page rulers along the top and left-hand
side of the layout, and by clicking on the rulers, guides are placed that allow the extents of the
data frames to be aligned. Because the study area contains multiple map areas, another data
frame is placed in the map to show the location of the current map area in relation to the entire
study area. Since Layout View is used solely for the creation of the maps, the data frame must
first be created in Data View. Once in Data View, the Insert dropdown is used to select Data
Frame, which inserts a new data frame into the ArcMap document. After double-clicking on the
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new data frame, Entire is entered as the name for the data frame, and the Add Data function is
used to add the MapAreas, inundation polygon, and Unites States counties layers. To
differentiate between the map areas, each map area is assigned a number. For this application,
the map areas are numbered from 1 to 23, starting with the map area containing the dam and
progressing downstream. After switching back to Layout View, the Entire data frame is
displayed in the minor data frame on the map, and the template is saved.
3.3.12 Set Up Main Data Frame
Once the minor data frame is set up as a spatial reference for the map, the main data
frame is modified for the proper display of the inundation. When working in Data View, the
display of data is consistent with the page instead of the coordinate system. However, Layout
View references the coordinate system when displaying data, which causes the map areas created
in Data View to be skewed in relation to the data frame. Thus, the map areas are aligned with
the data frame by modifying the display properties of the data frame. In Layout View, the main
data frame is selected and right-clicked upon, and Properties is chosen from the Options
dropdown. In Data Frame Properties, shown in Figure 27, the General tab is used to specify the
Rotation for the data frame. For this research, a Rotation of -9.1 is used to align the map areas
with the data frame.
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Figure 27: Properties for Main Data Frame

3.3.13 Arrange Main and Minor Data Frames
After the rotation for the data frame is set, the first map area is displayed by aligning the
rectangle’s sides with the data frame boundary. The scale is also specified to ensure that the
entire map area is displayed in the data frame. Since the MapAreas rectangles may interfere with
the display of information, the layer is turned off once the placement of the map area is
complete. To show the location of the map area in the minor data frame, the Entire data frame is
right-clicked in the Table of Contents, and Activate is chosen. In order to highlight the current
map area, the Attribute Table for the MapAreas layer is opened, and the gray box to the left of
the first map area is selected. By highlighting the map area, the minor data frame displays the
location of the river segment in the main data frame in relation to the entire river.
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3.3.14 Add Essential Map Components
In addition to the two data frames, the inundation maps are further customized by
inserting legends, titles, and other map elements. In order to communicate the symbols used in
the map, a legend is created for the critical infrastructure. Using the Insert dropdown, Legend is
selected, opening the dialog box displayed in Figure 28. In the dialog box, the critical
infrastructure layers to be included in the legend are moved to the Legend Items section. After
choosing a legend template, the legend is added to the map and placed in a desired location.

Figure 28: Insert Critical Infrastructure Legend

To avoid confusion, another legend is created using the same procedure in order to
indicate the color of the inundation polygon in the maps. Additional elements such as a bar scale
and north arrow are added to provide context for the inundation maps. Under the Insert
dropdown, Scale Bar and North Arrow are each used to add these elements. Furthermore, a title
indicating the time step of the inundation map is specified. As a final step, the profile of the
representative cross-section is added to the inundation map. Using the Insert dropdown, Picture
is chosen, and the saved profile image is selected. After the profile is inserted, the image is
double-clicked, and the desired dimensions are specified. Once these map elements are inserted,
the first inundation map is complete. After saving the map, the second map area is displayed in
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the main data frame, and the procedure is repeated for the remaining map areas depicting the
inundation for the time step. Once the set of maps for the time step is finished, the process is
continued for the other time steps in the analysis.

3.4 Water Depth Grids Procedure
The Water Depth Grids procedure follows the same mapping process as the Terrain Tiles
procedure, but uses the inundation with the water depth grids rather than the inundation polygon.
Since the display properties of ArcMap allow for the classification and color-coding of the flood
water depths, this procedure provides additional information on arrival times and flood impacts
on critical infrastructure.
3.4.1 Mosaic Depth Grids
After opening a new ArcMap document, the Add Data function is used to add in the grid
files that contain the water depths. In ArcToolbox, the Data Management Tools category is
expanded, and Mosaic to New Raster is used to facilitate the processing of the data. In the
Mosaic to New Raster dialog box, shown in Figure 29, the files are grouped together based on
adjacency and proximity to cities, and recognizable names are given to each of the group files
that are created. In addition, an output file location is chosen, which provides a means to manage
and store the data.
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Figure 29: Mosaic to New Raster

3.4.2 Classify Depth Grids
After Mosaic to New Raster is complete, the group files are added into ArcMap using the
Add Data function, and the individual files that make up the group files are removed. Next, the
group files are classified to show the differing water depths. Each group file is right-clicked in
the Table of Contents, and Properties is chosen from the menu. In the Layer Properties dialog
box, the Symbology tab is selected. In the Symbology tab, illustrated by Figure 31, Classified is
chosen, which requires the creation of a histogram. Once the histogram is created, the water
depth intervals are changed by choosing Classify, as illustrated by Figure 30. For this
application, the intervals are chosen as 0 to 5 feet, 5 to 10 feet, 10 to 20 feet, 20 to 30 feet, 30 to
40 feet, and greater than 40 feet. These intervals are based on the total depth of the flood. Next,
the color ramp is changed from a Black to White color scheme to the Spectrum-Full Light color
scheme, as shown in Figure 31, so that there is a clear differentiation in the water depth intervals.
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Figure 30: Classify Histogram

Figure 31: Assign Color Scheme

3.4.3 Set Up Map Template
The process of setting up the map template is the same as the one outlined in Section 3.3,
except a water depth legend is inserted in place of the flood extents legend. To do this step, the
Insert dropdown menu is selected, and Legend is chosen. Inside the Legend Wizard dialog box,
shown in Figure 32, only one of the water depth grids is chosen, as all the grids have the same
water depth intervals. After this step, a template for the legend is selected, and OK is clicked to
insert the legend into the inundation map.

Figure 32: Add Water Depth Legend
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3.5 Virtual Inundation Mapping Using Google Earth
An alternative method to the process of making traditional paper maps is to import the
inundation into Google Earth. Google Earth contains high-resolution aerial imagery and
topography of the entire globe, and imported data is overlain on this background, providing a
means of visualizing the data in a real-world environment. Since the inundation is exported from
ArcMap at a one-to-one scale, the inundation boundaries in Google Earth are still accurate to
within two meters. Therefore, the impacts of the dam failure on the areas downstream are
analyzed at the same level of accuracy as in the paper maps.
3.5.1 Convert to KML File
Once the inundation has been generated in ArcMap, ArcToolbox is used to convert the
file into a form that can be processed by Google Earth. In ArcToolbox, the 3D Analyst Tools
category is expanded, followed by the Conversion category. Next, the To KML category is
expanded, and the Layer to KML Tool is selected, which opens the Layer to KML dialog box,
shown in Figure 33.

Figure 33: Layer to KML
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The layer to be converted is selected as the inundation, which is either the inundation
polygon or the inundation with water depth grids. For the output file, the destination folder is
specified, and a name for the KML file is given. The layer output scale represents the scale at
which the layer is exported. In order to view the layer as the inundation would appear in
actuality, the number one is entered for the output scale. Clicking OK converts the layer to a
KML file and saves the file in the specified destination.
3.5.2 Import into Google Earth
Once the KML file has been created, the file is imported into Google Earth. After
opening Google Earth, the File menu is used to select Open. In the dialog box, the KML file
containing the inundation polygon is selected, and Open is clicked, as shown in Figure 34.

Figure 34: Import KML File

The ArcMap layer appears in the Temporary Places folder in the sidebar of Google Earth,
and the inundation polygon is displayed at its correct geographic location on the virtual globe.
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3.5.3 Assign Transparency
The inundation polygon covers up the aerial images underneath, which may interfere
with the analysis. In order to change this display, the slider located in the sidebar is used to
assign a transparency to the inundation polygon so that the flooded areas can be seen through the
inundation. Figure 35 shows the imported inundation with an assigned transparency displayed in
Google Earth.

Figure 35: Inundation with Assigned Transparency

3.5.4 Display Analysis Layers
Once the inundation has been imported, Google Earth provides several analysis tools to
study the impacts of the flood. First, the inundation is viewed in a two-dimensional plan view,
and Google Earth has several built-in layers that are used to identify critical infrastructure.
These layers include city labels, transportation systems, and the locations of emergency services
facilities and public health and healthcare providers. To turn on these layers, the Layers menu in
the Google Earth sidebar is used to display the desired information on the virtual globe. The city
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labels are viewed by checking the Borders and Labels category, and the transportation systems
and labels are added by checking the Roads category. Critical infrastructure is found by
expanding the More category, followed by Place Categories, and the applicable layers are
chosen. Figure 36 shows the impacts of the flood on critical infrastructure, such as
transportation systems, emergency responders, hospitals, and schools. Thus, this view offers a
means of determining important evacuation centers and the affected transportation routes, which
is beneficial to emergency response planning.

Figure 36: Plan View with Critical Infrastructure

3.5.5 Enter Ground-Level View
Google Earth offers the capability to view projects from ground-level. To enter GroundLevel View, the orange human icon on the right side of the screen is selected and dragged to the
desired area. Once in this view, the arrow keys are used to navigate the virtual globe. Figure 37
illustrates the inundation displayed on the three-dimensional topography. The inundation
remains two-dimensional, showing the extents of the flood overlain on the existing topography
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without any water depths. However, this view is still useful to examine the effects of the
topography on the flood’s movement downstream.

Figure 37: Ground-Level View

3.5.6 Display Three-Dimensional Buildings
Google Earth also contains a database of three-dimensional structures that can be
displayed. While in Ground-Level View, these structures are activated by checking the 3D
Buildings category in the Layers menu in the sidebar. Although the database only contains a
select number of structures, the structures provide landmarks to enhance the spatial reference for
the analysis of the inundation, as illustrated in Figure 38.
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Figure 38: Ground-Level View with 3D Buildings

3.6 Overview of Created Maps
For this research, a dam failure was simulated for a candidate river system using HECRAS. Hourly intervals were specified for the output data to ensure that the entire flood event
was captured in practical time steps for emergency response. The crucial hours started at the
time of dam failure and ended at the time of the peak flood at the last cross-section in the study
area. Because of the length of the flood event, intervals of three hours were chosen to map the
flood’s propagation through the study area. These intervals allowed for key periods of the rising
and falling limbs of the event to be mapped for each section of the study area. Maps were
produced at three-hour intervals for each of the 23 map areas for 16 separate times after dam
failure, resulting in a total of 368 maps.
Sections 3.6.1, 3.6.2, and 3.6.3 present maps produced using the separate mapping
procedures used in this research. Section 3.6.1 illustrates three inundation maps produced by the
Terrain Tiles procedure, each showing a different time step for a candidate river segment. The
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first map depicts the inundation during the hour when the dam fails. The second map displays
the maximum inundation. The third map represents the falling limb of the event, when the
inundation waters have begun to recede. Similarly, the maps in Section 3.6.2 show the same
time steps, but with the water depths for the inundation classified. Section 3.6.3 illustrates the
inundation from the two previous sections imported into Google Earth. The mapping procedures
and outputs are further discussed and analyzed in Section 4.0.
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3.6.1 Terrain Tiles Maps

Figure 39: Flood Extents at 0 Hours

51

Figure 40: Flood Extents at 21 Hours
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Figure 41: Flood Extents at 43 Hours
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3.6.2 Water Depth Maps

Figure 42: Water Depths at 0 Hours
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Figure 43: Water Depths at 21 Hours
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Figure 44: Water Depths at 43 Hours
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3.6.3 Google Earth Maps

Figure 45: Flood Extents at 0 Hours in Google Earth
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Figure 46: Water Depths at 0 Hours in Google Earth

58

Figure 47: Flood Extents at 21 Hours in Google Earth
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49: Water
Flood Extents
Figure 48:
Depths at 43
21 Hours in Google Earth
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Figure 50: Water Depths at 43 Hours in Google Earth
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4.0 Analysis of Mapping Methods
Once the maps have been developed, an analysis is performed in order to evaluate the
output from each method in regards to ease of development, display of critical information, and
accessibility. This analysis focuses on the benefits and weaknesses of using these methods and is
related to the comparison between paper and virtual maps.

4.1 Terrain Tiles Strengths
The output derived from the Terrain Tiles procedure is a high-quality inundated area, as
shown in Figure 51. The terrain tiles break up the river reach into smaller segments, allowing
HEC-GeoRAS to process data for each individual tile rather than for the entire reach. As a
result, the inundation generated is an accurate representation of the flood’s movement
downstream from the dam. The inundation conforms to topographic controls on the landscape
and accurately represents flow around river bends and into tributary streams. Thus, the resulting
maps show the full impacts of the flood on critical infrastructure sectors located along the main
river channel and in outlying areas. Furthermore, the Water Depth Grids procedure provides
further visualization of the severity of flood levels with clear distinctions between water depth
intervals. These features are beneficial to emergency response planning by allowing agencies to
view the full extents of the flood at a particular time as well as the depth of water at key points.
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Figure 51: Terrain Tiles Inundation with Water Depths

4.2 Terrain Tiles Weaknesses
Although this method has many strengths in regards to the quality of the output produced,
the method has several weaknesses regarding the setup and file management. The initial setup
must be performed by the user, and this process is very labor-intensive, requiring the creation of
clipped DTMs and the terrain tiles. Additionally, once the setup is complete, HEC-GeoRAS can
take long periods of time to compute the inundation. This processing time varies depending on
the size of the study area and the number of terrain tiles, but for this application, the inundation
for the smallest river reach took four hours. For the entire study area, the process ran for 18 to
48 hours. Once the processing has completed, the resulting file sizes are very large, which can
be difficult to manage. For instance, the inundation for the entire study area required 190
gigabytes of memory for a single hour after the dam failure. Since 16 hours were modeled for
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this research, the total memory requirement exceeded three terabytes. Hence, the file sizes that
result from this method must be considered. Once the inundation has been generated, another
step that must be performed to study the impacts is to add the FEMA critical infrastructure
sectors. This data can be difficult to obtain for a particular study area and may have to be created
by the user. Furthermore, to provide a spatial reference for the inundation, background imagery
such as contours or aerial photography must be acquired and inserted manually into the maps.
Due to the overlay feature in ArcGIS, the critical infrastructure sectors may interfere with the
assessment of the flood’s true extent and impact. For instance, Figure 52 shows a transportation
route that is highlighted in green covering the outer boundary of the inundation. As a result, the
two-dimensional display properties leave uncertainty as to the viability of using this route for
emergency response.

Figure 52: Terrain Tiles Overlay Issues
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After the maps are created, online file sharing may also prove to be problematic. The
uploaded maps and associated files are in the form of ArcGIS layers, and the personnel from
various agencies who need access to the maps may not be familiar with the GIS software. This
lack of familiarity could result in misinterpretation of the information that the maps contain.
These weaknesses may cause the Terrain Tiles procedure to be unsuitable for some applications
where map files and printouts must be disseminated among numerous departments and agencies.

4.3 Google Earth Strengths
The benefits of Google Earth are a direct result of the virtual globe environment. After
importing the inundation from ArcMap, the flood appears in its correct geographic location on
the surface of the globe. Since Google Earth already contains aerial images, topography, and
critical infrastructure, no further data acquisition and manipulation are required once the
inundation is generated. Also, Google Earth provides an interactive map, allowing for the entire
study area to be viewed much more easily than with a series of paper maps. The inundation can
be shown in either a two-dimensional plan view similar to a paper map, or in a three-dimensional
Ground-Level View which shows the topography more easily than a contour map. GroundLevel View can also be used to provide further analysis on the impacts of the inundation that
may not be readily apparent in a two-dimensional view. For example, the highlighted route in
Figure 52 is overlain on the inundation, which hinders the determination of whether the route
remains a functional means of transport during the flood. However, viewing this transportation
route in Ground-Level View, as shown in Figure 53, reveals that the flood clearly impacts this
route, indicating that alternate routes should be investigated for emergency transport. Hence,
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Ground-Level View can be used in both emergency planning and response to illustrate the actual
consequences of the inundation.

Figure 53: Google Earth Ground-Level View

Furthermore, Google Earth supports online file sharing across organizations, allowing
users to access the maps in the field using Android phones and tablets, iPhones, and iPads. The
Google Earth environment is a user-friendly medium for the display of the inundation, as the
simplicity of the program removes the steep learning curve associated with technical mapping
software. As a result, the impacts of the flood can be understood and evaluated by users of all
levels of technical experience. Also, the lack of processing tools in Google Earth prevents the
corruption of the inundation data produced in ArcGIS Desktop. These aspects make Google
Earth an effective tool for sharing vital information about the flood among emergency response
agencies.
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4.4 Google Earth Weaknesses
While the virtual maps produced by Google Earth can provide many benefits, there are
also a few weaknesses to using this method. First, Google Earth does not perform inundation
calculations; thus, the inundation must be produced in ArcMap using the Terrain Tiles
procedure. Also, the Google Earth environment does not allow for the arrival times and water
depths of the inundation to be easily shown. Changes in inundation over time are best shown by
a side-by-side comparison of a particular area at different time steps, which cannot be easily
performed within Google Earth since only one inundation is effectively displayed at once. Also,
while the classified water depth grids can be imported into Google Earth, there is no legend to
explain the water depths corresponding to each color, which can cause confusion among users
who are not familiar with the development of the virtual map. Furthermore, the color-coded
inundation appears to be represented by geometric shapes, obscuring the clear divisions between
the water depth intervals. Figure 54 illustrates the display of the water depths in Google Earth,
which contains far less detail than the water depths shown in Figure 51. Thus, using Google
Earth to display water depths may lead to confusion in the delineation of the areas where the
high flood levels necessitate immediate evacuation, possibly putting lives in danger.
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Figure 54: Google Earth Water Depths

Further weaknesses of this procedure are related to the online sharing capability of
Google Earth. While Google Earth is an effective means of distributing the inundation maps, the
storing of the information online can be problematic. Since the consequences of a dam failure
are sensitive information, posting the maps online can provide a greater risk of access and use by
unauthorized persons, which may pose a security threat. As a result, these aspects of using
Google Earth for the production of inundation maps must be considered for each application.

68

5.0 Conclusions
Floodplain management serves a crucial role in the prevention of flood damage to
property and the public. Through the use of inundation maps, engineers and emergency
responders analyze the flood impacts resulting from a potential dam failure and develop
mitigation procedures for inclusion in Emergency Action Plans. The inundation is generated
based on a HEC-RAS model of a dam and river network, and HEC-GeoRAS, ArcGIS, and
Google Earth are used to create maps from the data. ArcGIS produces a paper inundation map,
while Google Earth provides the capability for virtual inundation maps. While both formats use
the same data, the presentation of the critical information varies. Thus, an assessment of the
strengths and weaknesses of the two mapping procedures was performed.
For this research, a dam failure was modeled for a river, and the resulting inundation was
mapped using both the Terrain Tiles and Google Earth procedures. An analysis of the two
mapping procedures identified the benefits and potential drawbacks of each based on criteria
relating to the ease of development, display of critical information, and accessibility. The
strengths of the Terrain Tiles procedure are that the time-stepped inundation maps clearly show
the arrival times of the flood into key areas and that the water depth intervals provide a
visualization of the severity of the flood. However, a weakness of this mapping procedure is that
the critical infrastructure data and background imagery may be difficult to obtain and the
incorporation of this data into the maps is a very labor-intensive process. Further weaknesses
relate to online file sharing, as the uploaded ArcGIS files require knowledge of GIS software for
the interpretation of the maps. On the other hand, Google Earth offers a user-friendly file
sharing environment that does not require technical software experience. Also, the uploaded
data cannot be corrupted since Google Earth does not contain ArcGIS processing tools. Further
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benefits are that Google Earth contains critical infrastructure and background imagery and that
the inundation can be viewed in two-dimensional and three-dimensional perspectives.
Weaknesses of the Google Earth procedure are that the inundation must still be produced in
ArcGIS, that the water depths and arrival times of the inundation are not as clearly displayed as
in ArcMap, and that the online file sharing may pose security issues.
Based on this analysis of the benefits and drawbacks of each mapping procedure, a
determination was reached as to the appropriate uses of each in floodplain management. Since
the Terrain Tiles procedure displays arrival times and water depths more clearly, these maps
should be used during the development of mitigation measures for Emergency Action Plans.
Due to the user-friendly online file sharing offered by Google Earth, these maps should be used
during an actual emergency response, as the maps could be accessed in the field by various
agencies performing emergency protocol. Future development of the Google Earth procedure
may include the refinement of displaying arrival times and water depths, as well as the ability to
view a three-dimensional inundation in Ground-Level View. These improvements would help to
further advance the development and use of inundation maps by floodplain managers and
emergency agencies.
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